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The major difference between the Tutorial and this documentation is that the tutorial uses a narrative which
can show you the flow of using the application. This documentation cannot follow that style.

We strongly recommend that you take a few minutes to use the Tutorial.

The Tutorial is available from the "Help" menu:

• "Open Tutorial HTML"
opens the HTML files which guide you through the tutorial

• "Create Document for Tutorial"
creates a Videocue document with sample media already loaded for you.

Quick Start. 

However, we have included a Quick Start chapter in this documentation to help you understand the bare
minimums.

Using this documentation. 

The screen shots used in this documentation were taking using the tutorial Videocue document.

You can open this document by selecting "Create Document for Tutorial" from the "Help" menu.

Menu Documentation. 

Oftentimes, perusing the menus of an application can help ground you in the application.

If you are looking for information on a specific menu (or menu item), the documentation can be found here.

Customer Support

Telestream is an online company -- we do all of our technical support through our website and email.

We highly value your feedback on our products, both positive and critical.

email contacts:

• Sales/Support: <support@telestream.net>

• Info: <info@telestream.net>

Website Links:

• Home: http://www.telestream.net

• Sales: http://www.telestream.net/purchase/store.htm

http://www.telestream.net
http://www.telestream.net/purchase/store.htm
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Chapter 2. Quick Start
Overview

Getting ready. 

Plug in your video camera and launch Videocue. Your window should look something like this:

Getting oriented. 

The top left area is the preview, where you will see the recording as it occurs.

The bottom left area is the where you'll find your media, cameras, and titles.

Your camera should appear as an icon in the "Media" tab. In this image, the camera is titled "iSight".

The large text area in the middle is where you'll enter the text you'll be reading.

The light blue column just to the right of the text is where you'll put your camera and other media.

Just below the text is where you'll edit the properties of selected media.

Enter the text you'll want to read. 

In the large text area in the middle of the screen, create the text of what you will want to say.

When you actually make a presentation, we suggest that you finalize the text you will read before adding
any media. This helps you organize your thoughts before focusing on the look of your presentation.

Adding your Camera. 

Drag your camera icon (ours is "iSight") to the line of text you want the camera to appear. Below, we have
put the camera on the first line. It should look like this:
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Rehearsing. 

You should sit back in your chair and relax. Practice relaxing each time before you record, it makes a
huge difference.

Press the Rehearse button to rehearse your presentation. (you can also use the spacebar if you are not
editing the text).

The rehearse button is the large arrow button just below the preview area:

Read the text as it enters the red band. 

It is important to read text only when it is in the red band at the top of the screen. This is so that your eyes
are as close to the camera as possible; you will appear as if you are talking directly to the camera.

Adjusting the speed of the prompter. 

While rehearsing or recording you can use the up and down arrow keys to adjust the speed until you are
comfortable.

You can also use the slider to adjust the speed, as shown below. The number to the right of the slider tells
you how long your presentation will last.

Stopping / Pausing. 

While rehearsing or recording you can stop the presentation by pressing the escape key (or by pressing
the stop button).

If you press the spacebar (or the pause button), the scroller will pause, but the video will continue recording.
This is very useful if you want to ad-lib, make an aside, etc.

Recording. 
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When you are comfortable with the speed and presentation, press the red record button and just read the
text as you did while rehearsing.

Reviewing / Saving the resulting movie. 

When the presentation is over (or you press escape), you will be presented with the Publish dialog:

Reviewing Changes. 

The top left corner of the window shows the movie you just recorded. You can review the movie by
pressing the play button just below the movie.

If you would like to re-record the movie, just cancel this dialog (or press escape).

Saving the movie. 

Name the movie by editing the "Filename" area, then press the "Save" button.

That's It. 

The basics of creating and recording a video are really that easy!
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Chapter 3. Main Window
Overview

The main window (or Document window) is made up of the following areas:

• Preview / Controls area -- Top left of window

• Media / Title / Narration -- Below the preview area - source media is here

• Text / Storyboard area -- Large text entry area - the text you'll read is here.

• Storyboard area -- Light blue area just to the right of the text area - drag your media here

• Editing - Media -- Edit Media that appears in the storyboard.

• Editing - Titles -- Edit Titles that appear in the storyboard.

• Editing - Chroma Key -- Edit the Chroma Key parameters.

• Editing - Motion -- Edit how media appears and disappears from the presentation.

• Editing - Transitions -- Edit Transitions for media/titles in the storyboard.

Preview / Controls

The Preview / Controls area is in the top left of the main window, and is shown here:
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The components of this area are:

• Preview

The large black area is where your video will be shown as it is being recorded (or as you rehearse).

• Master Audio

This slider controls the master output audio as saved into the resulting movie. There is a meter where
you can see the levels that are playing

• Record / Rehearse / Stop

Record - The left most button - will start recording the current presentation.

Rehearse - The middle button - will start the current presentation so that you can rehearse it. When you
are rehearsing or recording, this button becomes the Pause button. If you are not editing your text, you
can use the space bar for this button.

Stop - the right most button - when you are rehearsing or recording, you can use this button to stop
the presentation.

• Speed

The bottom part of this area controls how fast the text scrolls.

The number to the right shows how many seconds the presentation will take. While the presentation is
running, this number will count up.
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Videocue ships with several professional titles you
can use in your presentations.

To see how to use a title, see the Titles chapter.

Narration Tab. 

It is very common when creating a presentation to
want to use the same audio input device (micro-
phone or camera) no matter what is being shown by
Videocue.

[for example, during your presentation, you may
wish to show a picture and not record your live cam-
era. if you were to do this without the Narration fea-
ture, you would not be able to hear yourself speak-
ing.]

The Narration feature allows you to define one input
device that will be always heard during your presen-
tation.

Simply use the popup to choose the device you wish
to narrate with.

Text Entry

The Text Entry area. 

The left side of the Main window is where you enter the text of your presentation.

The light blue side to the right is the storyboard
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We suggest that you finalize the text you will read before adding any media. This helps you organize your
thoughts before focusing on the look of your presentation.

To modify the font or font size, use the Font menu.

Storyboard

The Storyboard. 

The right side of the Main window (in light blue) is the Storyboard.

The left side of this area is the text entry area.

Putting media in the storyboard. 

You can drag media (your camera, for example) from the media tab to the storyboard.
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When you put an item on the storyboard, it is associated with a particular line in your presentation.

When you are recording or rehearsing, and the associated line goes through the red area, the media will
become active.

Here is a picture of a camera on the first line in the storyboard:

Layers. 

Sometimes you may want some media to be shown above other media.

For example, if you want to add a title, you'll want the title to appear above your camera in the output.

To allow you to do this, Videocue's storyboard has three (3) layers you can use.

By default, only the normal layer is shown. To show the other layers, see the Storyboard menu.

For more information on layers and how to use them, refer to the Storyboard Layers section.

Storyboard Layers

The Storyboard. 

By default, Videocue displays only one layer:
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Showing another layer. 

However, there are times when you may want some media to appear above your camera.

You can accomplish this in Videocue by using Layers.

Select "Foreground Layer" from the Storyboard menu (or Command-2).

Your storyboard will now have two layers shown (below, we have already added a title to the layer):

What happens when rehearsing or recording. 

Each media is associated with a particular line in the text.

When that line goes through the red area (while recording or rehearsing), That media will become part
of your presentation.
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The media will remain in the presentation until another media replaces it, or you can use the "Blank" media
to remove media at a later time.

Preview all Layers. 

By selecting "Preview all Layers" from the Storyboard menu, you can see all layers while you are editing
one layer.

An example. 

For an example of this, see the section on Adding Titles in this manual.

Editing Media

The bottom part of the main window contains the shot edit area, which looks like this when you are editing
media (cameras, movies, logos, photos, etc).

The Editing Transition section shows how to modify the transition for this media.

Changing the Media for the shot. 

Drag another piece of media from the Media Tab to
the "Media" drop well.

Changing media opacity. 

Use this control to change the opacity (transparency)
of the media.

Changing shot volume. 

Use this control to change the volume of the media.

This control is only available if the media has audio.



http://graphicssoft.about.com/od/freedownloads/l/blframes_t02.htm
http://graphicssoft.about.com/od/freedownloads/l/blframes_t02.htm
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By default, the media will fade in and fade out, as shown here:

Build In. 

The controls on the left control how the media will enter the presentation.

The popup controls from where the media will enter (top, left, etc.)

The checkboxes control other actions, such as whether the media fades, spins, scales, or decelerates when
building in.

Build Out. 

The controls on the right control how the media will leave the presentation.

The popup controls toward which direction the media will leave (top, left, etc.)

The checkboxes control other actions, such as whether the media fades, spins, scales, or accelerates when
building out.
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Chapter 4. Publish
Overview

How to access. 

When you have finished a recording the publish dialog will automatically appear.

If, after publishing to one destination, you wish to publish the same movie to another location, you can
simply select "Publish..." from the , or press command-P. You can publish the same movie as many times
as you like until you record a new movie, or quit Videocue.

Below is the publish dialog:

The Preview. 

The leftside of the publish window is where you can preview the movie that you have created.

If you would like to record again, simply cancel this dialog and record again.

Read Using the Preview to learn how to use the preview area.

Saving your movie to disk. 

The Save to Disk section shows you how to do this.

Note
You can pre-configure several different disk locations by using Locations. To read about this,
see the Save to Another Location section.

Saving your movie to .Mac. 

The Save to .Mac section shows you how to do this.

Saving your movie to another location (FTP server, etc). 

The Save to Another Location section shows you how to do this.

Using the Preview

How to access. 

The preview area is the left side of the Publish window, as shown here:
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Movie Controls. 

To start the movie press the button on the left side of these controls. (or press the spacebar).

When the movie is playing the spacebar will pause the movie or you can use the pause button.

You can "scrub" aound in the movie by using the slider to move to a place in the movie you are interested in.

To review the movie in QuickTime Player, click the popup on the right side of the controls and select
"Open in QuickTime Player"

Note
You can also double click on the movie itself to open in the QuickTime Player.

Movie Information. 

Just below the Movie Controls, you'll see some information about the movie itself: The file size and it's
duration.

This can be helpful for you to decide whether it's the right size/length to publish.

Save to Disk

How to access. 

To save your movie to disk, you'll be using the Publish window, as shown here:

Quick Save. 

Change the name of your movie (the default is "MyMovie.mov").
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Press the "Save" button.

Your movie is saved to the "Movies" directory.

Changing the Directory to save to. 

If you'd like to change the directory you save your movies to, simply press the "Browse" button. You can
choose any directory you like.

This information is stored in your document, so that the next time you use this Videocue document, the
directory you set here will be remembered.

Changing the filename. 

No matter how you have configured your publish settings, you must always set the final filename for your
movie here.

Enter the name you'd like your file to be, and press Save.

Creating new Locations. 

You can create locations for different directories, or save your file to a server using FTP.

To do this, you'll need to add a Location Preset by pressing the "Edit..." button on this tab.

Save to .Mac

OS 10.4 only. 

The automatic upload to .Mac is a 10.4 only feature.

If you'd like to upload to your .Mac account with 10.3.9, simply use the Save to Disk feature and save
directly to your .Mac disk.

Select .Mac Account from Location Popup. 

If you have not yet configured your computer to know about your .Mac Account, You need to do so. To
do this, go to System Preferences (in the Apple Menu), click on the ".Mac" icon, and enter your .Mac
account information.

If you do not have a .Mac account, you can go directly to create an account (or a 60 day free trial), by
using the button provided within Videocue.

Once you have configured your .Mac account in System Preferences, you will see the following:
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.Mac Directory. 

By default, your movies will be put to the Public directory on your .Mac account.

This is so that other users can see your movies.

You may change the directory by entering it here.

Name the file. 

Enter the name of the file, then press "Publish".

Your file will be uploaded to your .Mac account.

Save to Another Location

Select the Location. 

To save to another location, simply select that location from the location popup which is available on the
right-side of the Publish window.

Below, is the window when you have selected a location other than "Local Disk":

Name the file. 

After selecting your Location, you still need to enter a filename, then press "Publish"

Adding / Editing Locations. 

To Add or Edit a location, press the "Edit..." button, or select "Location Presets" from the Window menu.

See Location Presets for information on editing a location.

Location Presets

How to Access. 

There are two ways to edit Locations:

The first is to press the "Edit..." button on the Publish window.
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The second is to select "Location Presets" from the Window menu.

Here is what the location manager looks like:

Location List. 

The left side of the window shows the list of locations.

Click on a location to edit it.

Use the plus and minus buttons to add and delete them.

Location Name. 

Enter the name for your location here.

Location Directory. 

If you select "Local Directory" from the popup, then the location defines a local directory on your disk.

Press the "Browse" button to select a directory to use for this location.

Using a local directory is very useful if you want to save a file to many different places on your local disk.

FTP Server. 

If you select "FTP Server" from the popup, then the location defines an FTP server.

Fill in the settings for your server.

The directory is the path on your server to the file, not the file itself, as that will be filled in on the Publish
window.
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• Those with hearing difficulties

• Those who have trouble understanding your spoken language (but can read it)

Note
The text is embedded as a secondary track in your QuickTime movie, which means that your
users can optionally turn it off. N.B. Your users need to have QuickTime Player Pro to turn off
the text track in QuickTime movies.
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New. 

Creates a new, empty Videocue document.

Open... 

Presents the Open dialog for you to choose a Videocue document from disk.

Open Recent. 

You can choose from up to 15 most recently accessed documents.

Every time you open or save a document, it is entered into the Open Recent list.

Save. 

Saves the document. If you haven't already saved the document to a file, then a Save As dialog is presented.

Save As... 

Presents the Save As dialog so that you can save a document.

Export Settings... 

Presents the Export Settings window, which allows you to change how your movie is exported.

Publish... 

Presents the Publish dialog, which allows you to save your movie to disk or to a server.

This option only exists when you have recorded a movie (use the Record button).

Close Window. 

Will close the foremost window.

If the document has not been saved, you'll be asked to save the document before closing it.

Edit

This section contains information on each item in the Edit menu of Videocue:

Undo. 

Your last change is undone.

Videocue offers an unlimited (memory permitting) amount of undo actions. However, some actions will
cause your undo information to be reset.

Redo. 

Your last undo is itself undone.

Videocue offers an unlimited (memory permitting) amount of undo actions. However, some actions will
cause your redo information to be reset.

Copy. 

Copies the text you currently have selected.
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If you are copying text from the Text Area and that text has associated shots, then those shots are also
copied. You can paste that text back into the same document.

Paste. 

Pastes the text you have copied into the text area.

Cut. 

The same as copy but the text is also removed.

Delete. 

Deletes the selected text, or selected shot if you are not editing text.

Select All. 

Selects all of the text in the text area.

Reset Position. 

If you have moved, resized, or scaled the media, this will reset the media back to its original position.

Configure Devices. 

To configure a camera (or other input device), select it from this menu.

Prompter

This section contains information on each item in the Prompter menu of Videocue:

Begin Recording. 

Will begin recording your presentation. This is the same as pressing the red record button.

Rehearse from position. 

Will immediately begin rehearsing your presentation from wherever it is currently scrolled to.

To rehearse from the start of the presentation, use the Start button.

Rehearse. 

Will begin rehearsing your presentation from the start (with a countdown).

This is the same as the Rehearse button.

Restart. 

Will scroll your presentation back to the start.

If you are recording, your current movie will be discarded and a new one started.

Scroll Prompter Faster. 

The prompter will scroll little faster.

Scroll Prompter Slower. 
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Opens the Location Presets window.

Help

This section contains information on each item in the Help menu of Videocue:

Help. 

Opens this documentation.

Open Tutorial PDF. 

Opens a PDF file which contains the directions for running the Videocue Tutorial.

To follow the tutorial, you'll need to Create a Document for the Tutorial as well.

Create Document for Tutorial. 

Creates a new Videocue Document which contains the media necessary for following the Tutorial.

Report a Bug. 

Your favorite web browser is pointed at our website to allow you to report a bug on our software.

Please give us as much information as you can about your computer, what you were doing and any sup-
porting material regarding the problem. For example, if a specific piece of media is troublesome, please
set it aside so that we can have a look at the problem first-hand.

If, in the unlikely event that Videocue crashes, you will find a file called "vara_debug.vara" in the /tmp
directory of your computer. If you can send that to us, it would be helpful as well.

Provide Feedback. 

Sends you off to our website where you can enter any feedback you may have about our product or com-
pany.

Visit Telestream Website. 

Sends you off to our website where in your favorite browser.
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Show the Titles. 

In the main window, select the "Titles" tab on the lower left of the window.

Drag a Title to the Title Layer. 

Drag a title (for example "Paris Blue") to the area to the right of the text, as shown here:
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You are now ready to modify the title. See these Editing Titles for more details.

Editing Titles

Before you can edit... 

To modify a title, you have to first Add a Title, then you need to select the title in the storyboard (the area
to the right of the text you'll read).

To select a title, just click on it in the storyboard area.

Below, we have selected the title we added in the Add a Title section:

Editing the title: 

Just below the large text area is where you do this.

















































http://www.paguk.com/lighting.htm
http://takegreatpictures.com/articles/default.asp?aid=670
http://www.diynet.com/diy/hp_cameras_equipment/article/0,2033,DIY_13955_2649634,00.html













	Videocue™
	Table of Contents
	Chapter 1. Videocue™ Introduction
	Welcome
	Registration
	Getting Started
	Customer Support

	Chapter 2. Quick Start
	Overview

	Chapter 3. Main Window
	Overview
	Preview / Controls
	Media / Title / Narration
	Text Entry
	Storyboard
	Storyboard Layers
	Editing Media
	Editing Titles
	Editing Transitions
	Editing Chroma Key
	Editing Motion

	Chapter 4. Publish
	Overview
	Using the Preview
	Save to Disk
	Save to .Mac
	Save to Another Location
	Location Presets

	Chapter 5. Export Settings
	Overview

	Chapter 6. Menus
	Overview
	Videocue
	File
	Edit
	Prompter
	Storyboard
	Font
	Window
	Help

	Chapter 7. Titles
	Overview
	Adding Titles
	Editing Titles
	Making a title exit
	Creating New Templates

	Chapter 8. Logos
	Overview
	Adding A Logo
	Making a Logo exit

	Chapter 9. Pictures and Movies
	Overview

	Chapter 10. Transitions
	Overview

	Chapter 11. Chroma Key
	Overview
	Lighting for Chroma Key

	Chapter 12. Preferences
	Overview
	General
	Register
	Performance
	Advanced

	Chapter 13. Editing Encoder Presets
	Overview
	Video
	Audio

	Chapter 14. Making good presentations
	Overview
	Lighting, lighting...
	Audio
	Movie file size

	Chapter 15. Hardware
	Overview
	FireWire (IEEE 1394)

	Chapter 16. Media Capabilities
	Overview
	Images / Opacity
	Movies
	MPEG-1 Audio
	AVI
	Windows Media
	Real Media


